
Open Power Point and you will be prompted by a dialog box with four choices. Each of these options are explained on this page. If Power Point is already open or this box does not appear, select File|New from the menu bar.


AutoContent Wizard 

The AutoContent Wizard provides templates and ideas for a variety of presentation types. Page through the wizard by clicking the Next button on the bottom of each page after making necessary choices.
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Design Template 

Power Point provides many templates with different backgrounds and text formatting to begin your presentation. Preview each design by highlighting the template name on the list. Press OK after you have chosen the design.
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Blank Presentation 

Select Blank Presentation to build the presentation from scratch with no preset graphics or formatting.

Open an Existing Presentation 

Select this option to open a Power Point presentation that already exists. Select the folder the file is located in from the Look in: drop-down menu and highlight the file on the list. Click Open to open the presentation.
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AutoLayout

After selecting the presentation type, you will be prompted to choose the layout of the new slide. These layouts include bulleted lists, graphs, and/or images. Click on each thumbnail image and a description will be printed in the message box. Highlight the layout you want and click OK.
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Screen Layout

The Power Point screen layout in Normal View:
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Views

Power Point gives you four screen layouts for constructing your presentation in addition to the Slide Show. You can select the page view by clicking the buttons just above the formatting toolbar and the bottom of the page.
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	Normal View
This screen is split into three sections showing the presentation outline on the left, the slide in the main window, and notes at the bottom.
	 
	Slide View
The slide view displays each slide on the screen and is helpful for adding images, formatting text, and adding background styles.
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	Outline View
The presentation outline is displayed on the majority of the screen with small windows for the slide and notes. This view is recommended for editing text. 
	 
	Slide Sorter View
A small image of each slide is displayed in Slide Sorter view. Slides can easily be ordered and sorted from this screen.


Click the Slide Show button to view the full-screen slide show.

Insert a New Slide [image: image11.png]



Follow these steps to insert a new slide into the presentation:

· In the Outline window, select the slide you want the new slide to appear after by clicking the slide's number. 

· Select Insert|New Slide from the menu bar or click the new slide button on the standard toolbar. 

· Choose the page layout from the window and press OK. 

Applying a Design Template

To add a design template or changing the existing one, selection Format|Design Template from the menu bar. Select the template and click Apply.

Changing Slide Layouts

To change the layout template of the slide select Format|Slide Layout from the menu bar. Select one of the layout thumbnail images and click Apply.
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Reordering Slides

To reorder a slide in Slide Sorter View, simply click on the slide you wish to move and drag it to the new location. In Normal or Outline View, click the slide icon [image: image13.png]


beside the number of the slide you want to move and drag the icon to a new location.

Hide Slides

If you do not want a slide to appear during the slide show, but do not want to delete the slide as it may be used later, the slide can be hidden by selecting Slide Show|Hide Slide from the menu bar. To add the slide back to the slide show, select Slide Show|Hide Slide again.

Create a Custom Slide Show

The Custom Slide Show feature allows you to select the slides you want to display in the slide show if not all the slides should be used.

· Select Slide Show|Custom Slide Show from the menu bar.
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· Click the New... button in the Custom Shows window. 

· In the Define Custom Show window, type a name for the slide in the Slide show name field.
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· Add slides to the custom show by highlighting them in the Slides in presentation window and clicking the Add >> button. Those slides will then appear in the Slides in custom show window. 

· To remove slides from the custom show, highlight their names in the Slides in custom show window and click the Remove button. 

· To reorder slides in the custom show, highlight the slide that should be moved and click the up and down arrows to change its order in the show. 

· Click OK when finished. 

· Click the Show button on the Custom Shows window to preview the custom slide show and click Close to exit. 

Edit a Custom Slide Show
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· Select Slide Show|Custom Slide Show from the menu bar. 

· Edit the show by highlighting the name in the Custom shows box and clicking the Edit... button. 

· To delete a show, highlight the name and click Remove. 

· Create a copy of a show by clicking the Copy button. The copy can then be renamed by clicking the Edit... button. 

· Click the Show button to preview the custom slide show and click Close to exit. 

Bulleted Lists on Design Templates

Bulleted lists allow you to clearly display the main points of your presentation on slides. The text boxes on design templates already include bulleted lists. Click the place holder on the slide to begin adding text and press the ENTER key to return to the next line and add a new bulleted item. To go to the next line without adding another bullet, hold down the SHIFT key while pressing ENTER. 

Bulleted List from a Text Box

If you are not creating a bulleted list from an existing placeholder on a design template, or if you would like to add an additional bulleted list, follow these steps to create a new list:

· In slide view, create a text box by selecting Insert|Text Box from the menu bar. 

· "Draw" the text box on the slide by holding down the left mouse button while you move the mouse until the box is the size you want it. 

· Choose Format|Bullets and Numbering from the menu bar.
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· Change the Size of the bullet by changing the percentage in relation to the text. 

· Choose a color for the bullet from the Color menu. Click More Colors for a larger selection. 

· Select one of the seven bullet types shown and click OK.
- OR -
Click the Picture button to view the Picture Bullet window. Select one of the bullets and click OK.
- OR -
Click the Character button to select any character from the fonts on the computer. Select a symbol font such as Wingdings or Webdings from the Bullets from drop-down menu for the best selection of icons. Click on the characters in the grid to see them larger. Click OK when you have chosen the bullet you want to use.
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· Click OK on the Bullets and Numbering window and use the same methods described in the "Bulleted Lists on Design Templates" to enter text into the bulleted list. 

Bulleted Lists and New Slides from an Outline

In Normal or Outline view, text can easily be entered in the outline window and new slides are automatically added. Follow the steps below to become familiar with adding slide content in outline view:

· Next to the Slide 1 icon, type the title of the slide. The text you type beside the slide icons will be the large-type titles on each slide. 

· Press ENTER to type the next line. This will automatically create a new slide. To create a bulleted list for the first slide, press the TAB key or click the demote button [image: image19.png]


on the More Buttons menu accessible by clicking the "triple arrow" button at the end of the formatting toolbar [image: image20.png]


.
- OR -
Press ALT+SHIFT+Right Arrow to demote the selection to a bulleted list item. 

· Continue entering text for the bulleted list, pressing ENTER at the end of each line to create a new bullet. 

· Create a multilevel list by executing the demote action again to create a bulleted sublist. Press the promote button [image: image21.png]


on the More Buttons menu or press ALT+SHIFT+Left Arrow to return to the original list. 

· Create a new slide by executing the promote action until a new slide icon appears. 

· Continue creating new slides and bulleted lists by using the demote and promote actions until the presentation is completed. Use the formatting instructions below to format the lists. 

If there is more than one bulleted list on the slide, the lists will be designated by numbers enclosed in black boxes. The example below shows the slide created from the outline on the left. The bulleted list on the left side of the slide is labeled list "1" on the outline and the list on the right is labeled list "2". When typing the outline, begin typing in the new list by pressing CTRL+ENTER. In this example, CTRL+ENTER was pressed after typing "Access".
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Numbered List

Follow these steps to create a numbered list:

· Create a text box. 

· With the text box selected, choose Format|Bullets and Numbering from the menu bar. 

· Click the Numbered tab at the top of the Bullets and Numbering window.
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· Change the size of the numbers by changing the percentage in relation to the text. 

· Choose a color for the numbers from the Color menu. Click More Colors for a larger selection. 

· Change the Start at value if the numbers should not begin with 1. 

· Select one of the the seven list types shown and click OK. 

Resizing a Text Box

Select a text box by clicking on it with the mouse. A border with nine handles will appear around the text box. The four handles on the corners will resize the length and the width of the box at once while the handles on the sides will resize only in one direction. Click one of the handles and drag it with the mouse. Release the mouse button when it is the size you want it to be. Move the text box by clicking and dragging the thick, dotted border with the mouse.
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Text Box Properties

Change the colors, borders, and backgrounds of a text box from the Format AutoShape dialog box.
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· Activate the textbox by clicking on it and select Format|Colors and Lines from the menu bar. 

· Under the Colors and Lines tab, select a Fill color that will fill the background of the text box. Check the Semitransparent box if you want the slide background to show through the color. 

· Select a Line color that will surround the box as well as a Style or Weight for the thickness of the line and a Dashed property if the line should not be solid. 

· Click the Text Box tab.
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· Change the Text anchor point to reposition the text within the text box. 

· Set Internal margins to the distance the text should be to the text box edges. 

· Click OK to add the changes to the text box.

Delete a Text Box

To delete a text box from a template, simply click the border of the text box and press the DELETE key on the keyboard.

Adding Notes

From Normal View, notes can be added to the slide. These notes will not be seen on your presentation, but they can be printed out on paper along with the slide the notes refer to by selecting Print What: Notes Pages on the Print menu.
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Video

To add a video to your presentation select Insert|Movies and Sounds|Movie from File or to insert an animation from Microsoft's gallery choose Insert|Movies and Sounds|Movie from Gallery. Select the video file and click OK.

Audio

To add sound to your presentation select Insert|Movies and Sounds|Sound from Gallery or Sound from File. Select a sound file and click OK.

Adding Text

If the slide layout includes text boxes, simply click on the text box to add text. To add a text box to the slide, select Insert|Text Box from the menu bar and draw the text box with the mouse. Set text editing options by selecting Tools|Options from the menu bar and clicking the Edit tab.
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Formatting Text

Select the text that will be formatted by highlighting the text either on the outline or on the slide. Choose Format|Font from the menu bar or right-click on the highlighted selection and select Font from the popup shortcut menu or. Select a font face, size, style, effect, and color from the Font dialog box. Click the Preview button to see how the changes will appear on the slide before making a decision.

Replace Fonts

Design templates have a preset font that you may want to change or you may want to change the font used on for the entire presentation for a number of reasons. This can be accomplished quickly using the Replace Fonts feature. Select Format|Replace Font from the menu bar. Choose the font you want to Replace from the first drop-down menu and the font it should be replaced With from the second menu, and click the Replace button.
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Line Spacing

Change the amount of space between lines in a text box by selecting Format|Line Spacing from the menu bar.
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· Line spacing - Select the amount of vertical space between lines. A value of "1" is equal to single spacing and "2" is double spacing. Values between and above these numbers are valid as well.

· Before paragraph and After paragraph - This value will determine the amount of vertical space before and after each paragraph in a text box. 

Change Case

Change the case of the characters in a paragraph by selecting Format|Change Case from the menu bar without having to retype the text. 
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· Sentence case - Capitalizes the first letter of the first word in each sentence. 

· Lowercase and Uppercase - Changes the case of all the letters. 

· Title case - Capitalizes the first letter of every word and reduces the rest to lowercase. 

· Toggle case - The opposite of Title case, it makes the first letter of every word lowercase and capitalizes the remaining letters. 

Spell Check

Correct the spelling in the presentation by selecting Tools|Spelling from the menu bar or by pressing the F7 key on the keyboard.
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· The spell checker will prompt you to make corrections of the first word that is spelled wrong. 

· If the word is spelled correctly, click Ignore or Ignore All if the same word appears several times during the presentation. If this word will appear in many presentations (such as your name), click Add to add the word to the dictionary and you won't be prompted by a misspelling again. 

· If the word is spelled wrong, highlight one of the the Suggestions or type your own revision in the Change to box. Click Change to correct this occurrence of the word or Change All to correct all occurrences of the word in the presentation. 

· Click Close to abort the spelling check early. 

· When the spell checker has read through the entire presentation, you will be prompted by a window telling you that the spelling check is complete. Click OK. 
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Spelling Options

Select Tools|Options from the menu bar and click the Spelling and Style tab.
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· Check spelling as you type - If this box is checked, Power Point will check the spelling of every word as you type. Misspelled words will be underlined with wavy red lines. 

· Hide spelling errors in this document - Check this box to remove the wavy red lines from words that are spelled wrong. 

· Always suggest corrections - If this box is checked, suggestions for misspelled words will appear when you activate the spell checker. 

· Ignore words in UPPERCASE - Power Point recommends that you don't type slide titles in all uppercase letters so it will treat words like this and other all-uppercase acronyms as misspelled. Check this box to ignore this suggestion and acronyms that are typically typed in all caps. 

· Ignore words with numbers - Check to ignore words that are combinations of letters and numbers. 
The colors of predesigned slide templates can be changed and a color scheme can be added to blank presentations. This page explains how to add color schemes and background images to slides.

Color Schemes

· Select Format|Slide Color Scheme from the menu bar. 

· Click one of the preset color scheme thumbnail images in the Color schemes box.
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· Click the Preview button to see how the scheme will appear on the slide. 

· To make changes to the color scheme, click the Custom tab on the dialog box. 
[image: image37.png]Color Scheme

Standord Custon |

Scheme colrs g

Backyround
Text and nes
Shadws Concel
Title text —
Fils

Accent.

Accent and hyperink

Accent and folowed hyperlik

apply

[ 1 |l Wl

Tie of Side.

- Bulet text

Changs clor. B m
[ s i |





· Change the colors of the slide elements by selecting the color swatch beside the name of the element and clicking the Change color button. 

· Highlight one of the colors from the Text and Line Color window or select the Custom tab to view more color choices and click OK when finished.
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· When you have finished all color formatting, click Apply to All to apply the color scheme to all the slides in the presentation or Apply to add the scheme only to the current slide. 

Backgrounds

Follow these steps to add background colors and patterns to a slide:

· Select Format|Background from the menu bar.
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· Select a color from the drop-down menu below the Background fill preview or choose More Colors... for a larger selection. 

· Select Fill Effects from the drop-down menu to add gradients, texture, patterns, or a picture to the background.
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· Gradient tab
· Select One color if the color chosen will fade into the background and select the color from the Color 1 drop-down menu. Choose Two colors if the gradient will use two colors and select those colors from the Color 1 and Color 2 drop-down menus. Preset provides a selection of color combinations. Select one from the Preset colors drop-down menu. 

· Select the type of gradient from Shading styles. 

· Click one of the four Variants of the styles chosen. 
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· Texture tab
From the Texture window, select a repeating background by scrolling through the thumbnail images or click Other Texture... to select an image from a file.
[image: image42.png]Fill Effects. [2]x]

ot | Tostwe | Pt | pere |

5 | W Cancel
Lz
[
B
BN\ [
- e B a3
Eoreground: Background:
(— 5|





· Pattern tab
Select a two-tone pattern by clicking one of the pattern swatches and selecting the Foreground and Background colors.
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· Picture tab
Click the Select Picture button to choose a picture from a file. After the picture is selected, a preview and description will be shown in this window. 

· Click OK to apply the changes made from the Fill Effects windows. 

· Click Apply to All to add the changes to every slide or Apply to make changes only to the current slide. 

The Drawing Toolbar provides many commands for creating and editing graphics. The toolbar is located at the bottom of the Power Point screen or it can be activated by selecting View|Toolbars|Drawing from the menu bar.
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· Menu - 

· Grouping - Images can be grouped together so they become one image and can be moved together or the same formatting changes can be applied to both at once. Select all the images that will be grouped by holding down the SHIFT key and clicking once on each image. Then select Group from the Draw menu. The images can be ungrouped by selecting Ungroup from the same menu. The rectangles in the image to the left are separate images with their own sets of handles and they are grouped together in the image to the right:
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· Order - The order of overlapping images can be changed using this feature. In the example of two rectangles below, the green rectangle is selected and the Send Backward command was used to move the image below the blue rectangle. Send Backward and Bring Forward will move elements by one layer. Send to Back and Bring to Front move the elements to the back or top of a series of several overlapping graphics.
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· Nudge - Use the nudge actions to move an object slightly in one direction. 

· Align or Distribute - Select a group of objects and choose one of the the commands from the Align or Distribute menu to change the position of the objects in relation to one another. 

· Rotate or Flip - Rotate an object 90 degrees or flip the object over its x- or y-axis. 

· Select objects - Deactivate all drawing functions. 

· Free rotate - This button will place green handles on certain objects so they can be arbitrarily rotated. Click and drag the handles to rotate the objects.
[image: image49.png]



· AutoShapes menu - Click the small down arrow to the right of the "AutoShapes" text to select a shape. [more...] 

· Line and Arrow - Click and drag the mouse on the slide to add lines. Hold down the SHIFT key to draw a straight line. Use the end points of the completed line to stretch and reposition the line. 

· Rectangle and Oval - Click and drag the mouse on the slide to add rectangles and ovals. Hold down the SHIFT key to add squares and circles. 

· Text box - Click to draw a text box on the slide. 

· Word art - Click to add WordArt. [More] 

· Picture - Click to add a clip art image to the slide. 

· Fill color - Choose a fill color for rectangles, ovals, and clip art. 

· Line color - Select a border color for shapes and pictures. 

· Font color - Highlight text on the slide and click the small down arrow next to the Font color icon to select a color. 

· Line style - Highlight a line or arrow that has been drawn and click this button to select a thickness or style for the line. 

· Dash style - Highlight a line or arrow and select a dash style. 

· Arrow style - Change the arrow head style for an existing arrow or change a line to an arrow. 

· Shadow - Select a text box to add shadow to text or choose any other object on the slide to add a drop shadow. 

· 3D - Add a three-dimensional effect to text and other objects. 

Adding Clip Art

To add a clip art image to a slide, follow these steps:

· Select Insert|Picture|Clip Art from the menu bar or click the Picture button on the Drawing toolbar..
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· To find an image, click in the white box following Search for clips and enter keywords describing the image you want to find.
- OR -
Click one of the category icons. 

· Click once on the image to want to add to the slide and a selection bar will appear. 

· Click once on the image you want to add to the slide and the following popup menu will appear:
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· Insert Clip to add the image to the slide.

· Preview Clip to view the image full-size before adding it to the slide. Drag the bottom, right corner of the preview window to resize the image and click the "x" close button to end the preview.
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· Add Clip to Favorites will add the selected image to your favorites directory that can be chosen from the Insert ClipArt dialog box. 

· Find Similar Clips will retrieve images similar to the one you have chosen. 

· Click the Close button in the top, right corner of the Insert Clip window to stop adding clip art to the slide.

Add An Image from a File

To add a photo or graphic from a file:

· Select Insert|Picture|From File from the menu bar.

· Click the down arrow button on the right side of the Look in: window to find the image on your computer. 

· Highlight the file name from the list and click the Insert button.
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Editing A Graphic 

Activate the image you wish to edit by clicking on it once with the mouse. Several handles will appear around the graphic. Click and drag these handles to resize the image. The handles on the corners will resize proportionally while the handles on the straight lines will stretch the image. More picture effects can be changed using the Picture toolbar.

Auto Shapes

The AutoShapes toolbar allows you to draw a number of geometrical shapes, arrows, flow chart elements, stars, and other graphics on a slide. Activate the AutoShapes toolbar by selecting Insert|Picture|AutoShapes or View|Toolbars|AutoShapes from the menu bar. Click the buttons on the toolbar to view the options for drawing each shape.
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· Lines - After clicking the Lines button on the AutoShapes toolbar, draw a straight line, arrow, or double-ended arrow from the first row of options by clicking the respective button. Click in the slide where you would like the line to begin and click again where it should end. To draw a curved line or freeform shape, select curved lines from the menu (first and second buttons of second row), click in the slide where the line should appear, and click the mouse every time a curve should begin. End creating the graphic by clicking on the starting end or pressing the ESC key. To scribble, click the last button in the second row, click the mouse in the slide and hold down the left button while you draw the design. Let go of the mouse button to stop drawing.

· Connectors - Draw these lines to connect flow chart elements.

· Basic Shapes - Click the Basic Shapes button on the AutoShapes toolbar to select from many two- and three-dimensional shapes, icons, braces, and brackets. Use the drag-and-drop method to draw the shape in the slide. When the shape has been made, it can be resized using the open box handles and other adjustments specific to each shape can be modified using the yellow diamond handles.
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· Block Arrows - Select Block Arrows to choose from many types of two- and three-dimensional arrows. Drag-and-drop the arrow in the slide and use the open box and yellow diamond handles to adjust the arrowheads. Each AutoShape can also be rotated by first clicking the Free Rotate button on the drawing toolbar [image: image56.png]


. Click and drag the green handles around the image to rotate it. The tree image below was created from an arrow rotated 90 degrees.
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· Flow Chart - Choose from the flow chart menu to add flow chart elements to the slide and use the line menu to draw connections between the elements.

· Stars and Banners - Click the button to select stars, bursts, banners, and scrolls. 

· Call Outs - Select from the speech and thought bubbles, and line call outs. Enter the call out text in the text box that is made.

· More AutoShapes - Click the More button to choose from a list of clip art categories.

Each of the submenus on the AutoShapes toolbar can become a separate toolbar. Just click and drag the gray bar across the top of the submenus off of the toolbar and it will become a separate floating toolbar.
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WordArt

Add headlines in striking colors and shapes to your presentation using Word Art.

· Select Insert|Picture|WordArt from the menu bar or click the Word Art button on the Drawing toolbar. 

· Choose a Word Art style from the listing and click OK.
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· Enter the text in the Edit WordArt Text box and choose the font, size, and style for the text. Click OK.
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· Use the white box handles around the word art to resize it on the slide. 

· Drag the yellow diamond handle to change the shape of the text. To revert back to no shape, double-click the diamond. 
Action Buttons

Use the action button toolbar to add functioning buttons to slides in a presentation.

· Select Slide Show|Action Buttons from the menu bar. Click the bar across the top of the button menu and drag it off the menu so it becomes a floating toolbar.
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· Click one of the button faces and draw the button on the slide using the mouse. The Action Settings menu will then appear.
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· Set the actions under either the Mouse Click or Mouse Over tabs. Actions specified for Mouse Click will execute when the button is clicked on the slide while actions for Mouse Over will occur when the mouse pointer hovers over the button. 

· Select an action for the button by choosing a Hyperlink to destination. 

· If you want a sound to be played when the button is clicked, check the Play sound box and choose a sound from the drop-down menu. 

· Click OK when finished.
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· The button on the slide can be resized using the white box handles and the depth of the button can be changed by dragging the yellow diamond.

Slide Animation

Several animations for slide objects are available through the drop-down menus on the menu bar. First, select the text box or graphic that will be animated. Select Slide Show|Preset Animation and choose from one of the options. To select a different animation or turn the animation off, select the appropriate choice from the same menu. For more options, follow the procedure below:
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· Select Slide Show|Custom Animation from the menu bar. 

· Select the object on the slide that will be animated from the Check to animate slide objects list. 

· Under the Effects tab, select the animation type (or select "No Effect" to turn an animation off) and direction from the drop-down menus and select a sound if you wish. 

· Select an After animation effect if the text should change colors after the animation executes. 

· Color palette - Select one of the color swatches or click More Colors for a larger selection. The text will change to the selected color when the mouse is clicked during the slide show. 

· Don't Dim - This option erases all After Animation effects. 

· Hide After Animation - Text will be immediately erased after the animation is completed. 

· Hide on Next Mouse click - The text will be erased when the mouse is clicked. 

· Choose the style of displaying the text under the Introduce text section. The drop-down menu provides options for displaying the characters for each bulleted item. Select "All at once" for the text to appear immediately, "by Word" for the text to appear one word at a time, or "by Letter" for a typewriter effect that displays one letter at a time. 

· Click the Order & Timing tab to alter the order that the objects appear on the slide. Highlight the object in the Animation order box and click the Move arrows to move the object's position within the animation sequence. Under Start animation, choose "On mouse click" to activate the animation by clicking the mouse or "Automatically" for the animation to execute after a set number of seconds.
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· Click the Preview button at any time to preview the animation on the slide and click OK when finished. 

Animation Preview

Select Slide Show|Animation Preview from the menu bar to view the Animation Preview window. Click anywhere within this window with the mouse to preview the animations that have been set. To hide the window, click the x close button in the top, right corner.
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Slide Transitions

Add transition effects when changing slides by following these steps:
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· Select Slide Show|Slide Transition from the menu bar. 

· From the Effect section, choose a transition from the drop-down menu and notice the preview after the transition is selected. Select a speed for the transition as well. 

· Under Advance, check "On mouse click" for the slide transition to occur by clicking the mouse or using keystrokes or check "Automatically after" and a number of seconds if the transition should occur automatically. 

· Select a Sound if necessary and check the Loop until next sound if it should keep repeating until the next sound is played. 

· Click Apply to All if the transition effects should be added to every slide or Apply if the effects should be added only to the current slide. 

Slide Show Options

Select Tools|Options and click the View tab to choose from several more slide show options.
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· Popup menu on right mouse click - Check this box if you want to be able to access the shortcut menu during a presentation. 

· Show popup menu button - Check this box to activate the menu button that appears in the bottom, left corner of the screen during a presentation.
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End with black slide - Insert a blank, black slide to the end of the presentation. Action Buttons

Use the action button toolbar to add functioning buttons to slides in a presentation.

· Select Slide Show|Action Buttons from the menu bar. Click the bar across the top of the button menu and drag it off the menu so it becomes a floating toolbar.
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· Click one of the button faces and draw the button on the slide using the mouse. The Action Settings menu will then appear.
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· Set the actions under either the Mouse Click or Mouse Over tabs. Actions specified for Mouse Click will execute when the button is clicked on the slide while actions for Mouse Over will occur when the mouse pointer hovers over the button. 

· Select an action for the button by choosing a Hyperlink to destination. 

· If you want a sound to be played when the button is clicked, check the Play sound box and choose a sound from the drop-down menu. 

· Click OK when finished.
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· The button on the slide can be resized using the white box handles and the depth of the button can be changed by dragging the yellow diamond.

Slide Animation

Several animations for slide objects are available through the drop-down menus on the menu bar. First, select the text box or graphic that will be animated. Select Slide Show|Preset Animation and choose from one of the options. To select a different animation or turn the animation off, select the appropriate choice from the same menu. For more options, follow the procedure below:
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· Select Slide Show|Custom Animation from the menu bar. 

· Select the object on the slide that will be animated from the Check to animate slide objects list. 

· Under the Effects tab, select the animation type (or select "No Effect" to turn an animation off) and direction from the drop-down menus and select a sound if you wish. 

· Select an After animation effect if the text should change colors after the animation executes. 

· Color palette - Select one of the color swatches or click More Colors for a larger selection. The text will change to the selected color when the mouse is clicked during the slide show. 

· Don't Dim - This option erases all After Animation effects. 

· Hide After Animation - Text will be immediately erased after the animation is completed. 

· Hide on Next Mouse click - The text will be erased when the mouse is clicked. 

· Choose the style of displaying the text under the Introduce text section. The drop-down menu provides options for displaying the characters for each bulleted item. Select "All at once" for the text to appear immediately, "by Word" for the text to appear one word at a time, or "by Letter" for a typewriter effect that displays one letter at a time. 

· Click the Order & Timing tab to alter the order that the objects appear on the slide. Highlight the object in the Animation order box and click the Move arrows to move the object's position within the animation sequence. Under Start animation, choose "On mouse click" to activate the animation by clicking the mouse or "Automatically" for the animation to execute after a set number of seconds.
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· Click the Preview button at any time to preview the animation on the slide and click OK when finished. 

Animation Preview

Select Slide Show|Animation Preview from the menu bar to view the Animation Preview window. Click anywhere within this window with the mouse to preview the animations that have been set. To hide the window, click the x close button in the top, right corner.
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Slide Transitions

Add transition effects when changing slides by following these steps:
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· Select Slide Show|Slide Transition from the menu bar. 

· From the Effect section, choose a transition from the drop-down menu and notice the preview after the transition is selected. Select a speed for the transition as well. 

· Under Advance, check "On mouse click" for the slide transition to occur by clicking the mouse or using keystrokes or check "Automatically after" and a number of seconds if the transition should occur automatically. 

· Select a Sound if necessary and check the Loop until next sound if it should keep repeating until the next sound is played. 

· Click Apply to All if the transition effects should be added to every slide or Apply if the effects should be added only to the current slide. 

Slide Show Options

Select Tools|Options and click the View tab to choose from several more slide show options.
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· Popup menu on right mouse click - Check this box if you want to be able to access the shortcut menu during a presentation. 

· Show popup menu button - Check this box to activate the menu button that appears in the bottom, left corner of the screen during a presentation.
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· End with black slide - Insert a blank, black slide to the end of the presentation. 
Save as Web Page

Presentations can be saved by selecting File|Save from the menu bar. However, if you want to post Power Point presentations on the Internet, you may want to save them as web pages so students and other visitors to your web site can view the presentation even if they do not have Power Point installed on their computers. Select File|Save As Web Page from the menu bar. Choose your web page directory on the network from the Look in: drop-down menu and name the file in the File name: box. Click Save to save the presentation in web format.

Page Setup

Select File|Page Setup from the menu bar to access options for printing the presentation slides. Select the format the printed slides will be used for from the Slides sized for drop-down menu or enter a specific print size using the Width and Height boxes. Select the page orientation for the slides and for other print material from the presentation in the Orientation section.
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Print

Select File|Print from the menu bar to print the presentation.
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Print range - Select All to print all the slides in the presentation, Current slide to print only the current slide, or enter slide numbers in the Slides field to print only certain slides.

Copies - Enter the number of copies of each slide specified in Print range and check the Collate box if necessary.

Print What - 
· Slides prints a full-page slide on each page. 

· Handouts prints as many slides as you designate on each page. 

· Notes Page prints one slide with that slide's notes on each page 

· Outline view prints the outline of the presentation 

Click OK to print.

Keyboard shortcuts can save time and the effort of switching from the keyboard to the mouse to execute simple commands. Print this list of Power Point keyboard shortcuts and keep it by your computer for a quick reference.

Note: A plus sign indicates that the keys need to be pressed at the same time.

	Action
	Keystroke


	Document actions
Open a presentation
CTRL+O
New presentation
CTRL+N
Save As
F12 
Save
CTRL+S
Print
CTRL+P
Help
F1
Presentation actions
Begin slide show
F5
Next slide
ENTER or
Down arrow key
Previous slide
BACKSPACE or
Up arrow key
Activate pen tool
CTRL+P
Erase pen strokes
E
Deactivate pen tool
CTRL+A
Show/Hide black screen
B
Show/Hide white screen
W
Show/Hide pointer & button
A
End slide show
ESC
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	Action
Keystroke
Formatting
Select all
CTRL+A
Copy
CTRL+C
Cut
CTRL+X
Paste
CTRL+V
Undo
CTRL+Z
Redo
CTRL+Y
Bold
CTRL+B
Italics
CTRL+I
Underline
CTRL+U
Left justified
CTRL+L
Center justified
CTRL+E
Right justified
CTRL+R
Promote list item
ALT+SHIFT+Left arrow
Demote list item
ALT+SHIFT+Right arrow or TAB
Editing
Find
CTRL+F
Replace
CTRL+H
Insert hyperlink
CTRL+K
New slide
CTRL+M
Spell checker
F7
Macros
ALT+F8



Run the slide show and press the F1 key to view all keyboard shortcuts applicable when running a slide show. 

Design Tips

· Use contrasting colors for the text and the background so the text will be easy to read.

· Use font size large enough to be seen from the back of the room where the presentation will be held. A font size of 24-point or larger is recommended.

· Use short phrases and sentences to convey your message.

· Use simple slide transitions. Too many different transitions will distract your audience from the subject of the presentation.

· Avoid cluttering the slides with too much text or graphics. Your audience should hear what you have to say and not be distracted by a busy screen.

· Keep text simple and easy to read by not using many different text effects such as bold, italics, underlining, larger font size for emphasis within a sentence, or a different font all on the same slide. 

Presentation Basics

· Begin the slide show by clicking the Slide Show button on the bottom of the screen. [image: image83.png]



· Move to the next slide by pressing the SPACE BAR, ENTER, PAGE DOWN, or right arrow keys or by clicking the left mouse button.

· Go back to the previous slide by pressing BACKSPACE, PAGE UP, or the left arrow key.

· To end the slideshow before it is complete press ESC on the keyboard.

· A pen tool is available for drawing on the screen with the mouse. Press CTRL+P or click the right mouse button at any time and a popup window will appear. Choose Pen and the pointer will change to a pen that allows you to draw freehand on the screen using the mouse. Press the E key to erase all pen strokes. Press CTRL+A to disable the pen feature and revert the pen back to a pointer arrow.

· If you would like to use the pen to draw on a blank screen during a presentation, press the B or W keys, or select Screen/Black Screen from the popup menu and the screen will turn black. Press B or W again or choose Next from the popup menu to return to the presentation when you are finished drawing.

· To hide the pointer and button from the screen press the A key.

· Be sure to preview the slide show using a projector if one will be used during the presentation. Words or graphics that are close to the edge of the screen may be cut off by the projector. 
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